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Overview 
The CY8CKIT-059 PSoC™ 5LP Prototyping Kit is a small but very 

powerful system. It contains a PSoC™ (Programmable System 

on a Chip) 5LP device which brings together the features of an 

ARM Cortex M3 microcontroller, a programmable logic device, 

and many analog functions into one package. A programmable 

routing fabric between the peripherals and the pins allows any 

function to be mapped to any pin. 

The PSoC™ target device on the kit includes full speed USB 

device capability which makes it possible to use it to create a 

custom operator interface for the FRC. Cypress Semiconductor 

- an Infineon Technologies Company- has created a firmware 

example so that the kit will enumerate as a USB game 

controller. With this firmware loaded into the PSoC™ 5LP, the 

FRC Driver Station is able to communicate with the prototyping 

kit as if it were a game controller (i.e. joystick). 

The example application provided below is configured with 8 

analog inputs, 22 digital inputs (typically used for buttons or 

switches), and 12 digital outputs (typically used for indicators 

such as LEDs). 

Note: The CY8CKIT-059 was provided to rookie teams starting in 2016 and is available through the First 

Choice store.  

Getting Started 

Hardware 
CY8CKIT-059 PSoC™ 5LP Prototyping Kit 

• Included starting in 2016 rookie KOPs 

• Available in the First Choice Store 

• Order from Infineon.com store 

• Order from Digikey.com 

• Order from Mouser.com 

USB A to Micro-B cable 

USB A male to USB A female extension cable (optional) 

• Order from Amazon.com 

• Order from Digikey.com 

• Order from Mouser.com 

https://www.infineon.com/cms/en/product/evaluation-boards/cy8ckit-059/
http://www.digikey.com/product-search/en?keywords=cy8ckit-059
https://www.mouser.com/ProductDetail/Infineon-Technologies/CY8CKIT-059?qs=PhR8RmCirEblciDRmpiVDw%3D%3D
http://www.amazon.com/AmazonBasics-Extension-Cable--Male--Female/dp/B00NH11R3I
http://www.digikey.com/product-detail/en/AK669%2F2-18-BLACK/AE10611-ND/2391690
http://www.mouser.com/ProductDetail/Tripp-Lite/U024-0003/?qs=sGAEpiMZZMuTlc58v6LktqtYX%2fAU5oyUdrPodUNdJAA%3d
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Software 
Depending on what you want to do with the prototyping kit, there are several different software 

packages to choose from: 

• In order to program the provided example Game Controller firmware, PSoC™ Programmer is 

required. This software is provided free by Infineon Technologies. 

 

• If you want to modify the firmware or create your own completely custom project, the PSoC™ 

Creator IDE can be used. This fully featured IDE is also provided free by Infineon Technologies. 

 

Note that the installer for PSoC™ Creator also includes PSoC™ Programmer so if you chose to 

install PSoC™ Creator, you do not need to install PSoC™ Programmer separately. 

 

• The CY8CKIT-059 PSoC 5LP Prototyping Kit web site includes links to the kit documentation as 

well as an installer that contains the documentation, firmware examples, the kit schematic, and 

kit layout files.  

 

Note that there is a full installer which includes PSoC™ Creator and PSoC™ Programmer and a 

minimal installer which contains only the kit files. i.e. if you have already installed PSoC™ 

Creator, you will only require the kit files 

 

Purpose Web Site Direct Download Link 

Program example game 
controller firmware to 
the kit 

PSoC™ 
Programmer 

PSoC™ Programmer 

View and modify the 
example game controller 
project or create your 
own custom project 

PSoC™ Creator PSoC™ Creator (includes Programmer) 

View kit documentation 
and design 

CY8CKIT-059 CY8CKIT-059 (includes Creator and Programmer) 
CY8CKIT-059 CY8CKIT-059 (kit files only) 

 

USB Connections 
The CY8CKIT-059 actually contains two PSoC™ 5LP devices – one is the target device and the other is 

used to program and debug the target device. Both devices have USB capability. The target device 

connects to a standard USB Micro type-B connector (labeled PSoC™ USB) while the programmer device 

connects to a board edge connector (labeled KITPROG USB). This board edge connector can be plugged 

directly into a USB type-A socket with no cable required. 

Therefore, use the USB edge connector when you want to program the target device, and use the USB 

Micro type-B connector when you want to use the target device (i.e. when you are using the PSoC™ 5LP 

as a game controller in this example). 

Note: a USB type-A male to USB type-A female extension cable can be used if the USB type-A socket is 

placed in such a way to make it difficult to plug directly into it. 

https://www.infineon.com/cms/en/design-support/tools/programming-testing/psoc-programming-solutions/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families
https://www.infineon.com/cms/en/design-support/tools/programming-testing/psoc-programming-solutions/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families
https://www.infineon.com/cms/en/design-support/tools/programming-testing/psoc-programming-solutions/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families
https://www.infineon.com/cms/en/design-support/tools/sdk/psoc-software/psoc-creator/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families
https://www.infineon.com/cms/en/design-support/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-files
https://www.infineon.com/cms/en/product/evaluation-boards/cy8ckit-059/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-dev_kit#!designsupport
https://www.infineon.com/cms/en/product/evaluation-boards/cy8ckit-059/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-dev_kit#!designsupport
https://www.infineon.com/cms/en/product/evaluation-boards/cy8ckit-059/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-dev_kit#!designsupport
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Power Considerations 
The CY8CKIT-059 can be powered in three ways: 

1. USB bus powered from the card edge connector 

2. USB bus powered from the Micro-B connector 

3. External 3.3V – 5.5V supplied at the VDD or VDDIO pins  

The kit will automatically draw power from the highest voltage supply so if an external supply is being 

used along with a USB connection then the external supply should be 5V or greater. It is recommended 

that not both USB connectors be attached at the same time to reduce the possibility of overloading one 

of the USB ports since all power will be drawn from whichever USB port is at a higher voltage. 

Loading Firmware 
In order to load the example project containing an HID game controller, follow the steps below. 

1. Locate the project’s firmware file (CyController1.hex). This file is included in the NI FIRST Update 

and is available on the Infineon FRC user page (https://community.infineon.com/t5/FIRST-

Robotics-Competition-FRC/gh-p/FRC) in the topic titled “PSoC 5LP Operator Interface for the 

FIRST Robotics Competition”. 

2. Install PSoC™ Programmer if you have not already done so. 

3. Connect the kit to a PC via the board edge connector (KITPROG USB). Drivers will be 

automatically installed. Wait for driver installation to complete before going to the next step. 

4. Open PSoC Programmer. This can be found at: 

Start -> All Programs -> Cypress -> PSoC Programmer 3.29.1 -> PSoC Programmer 3.29.1 

5. Once Programmer starts, it should connect to the KitProg automatically and power the board as 

shown in the figure below. If the kit is not connected, click on the KitProg in the Port Selection 

window. 
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Note: if you get a message that your programmer is out of date, go to the Utilities tab and click 

on Upgrade Firmware as shown below. 

Note: if the KitProg does not show up in the Port Selection window, see the Troubleshooting 

section. 

 

 
 

6. Verify the programming parameters are as shown in the figure below. Note that the file path 

will be different than what is shown in the figure. You will select the file in the next step. 
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7. Chose File -> Load and navigate to the firmware file that you downloaded in step 1. 

8. Chose File -> Program to program the firmware. You should see a programming succeeded 

message as seen in the figure below. 

 

9. Remove the board edge connector the USB port before connecting a cable to the Micro-B 

connector. 
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Using the CY8CKIT-059 as an HID Game Controller 

USB Connection 
Once the example firmware has been programmed into the kit, connect it to a PC using a USB type A to 

Micro B cable. Once drivers have installed, you will see the device appear as a joystick in the Driver 

Station software. 

Pin Assignments 
The example firmware provides 8 analog inputs, 22 digital inputs (typically used for buttons or switches), 

and 12 digital indicator outputs (typically used for LEDs). The pin assignments are illustrated in the 

figure. 

Analog 1 (X)

Analog 8 (DIAL)

Analog 7 (SLIDER)

Analog 6 (RZ)

Analog 5 (RY)

Analog 4 (RX)

Analog 3 (Z)

Analog 2 (Y)

Button 1

Button 8

Button 7

Button 6

Button 5

Button 4

Button 3

Button 2

Button 17

Button 22

Button 21

Button 20

Button 19

Button 18

Button 9

Button 16

Button 15

Button 14

Button 13

Button 12

Button 11

Button 10

Indicator 1

Indicator 6

Indicator 5

Indicator 4

Indicator 3

Indicator 2

Indicator 7

Indicator 12

Indicator 11

Indicator 10

Indicator 9

Indicator 8

Connect USB 

here to program 

firmware

Connect USB 

here to use in 

the OI

 

Note: the pin used for Button 10 (P2[1]) is connected to an LED on the board. That LED will turn on when 

Button 11 is pressed. This is normal behavior and can be ignored. If you don’t want the LED to light, you 

can either not use Button 11 in your design or you can remove the LED from the board. Removing that 

LED will not cause any functional issues with the board.   



Page 8 of 13 
 

Analog Inputs 
Eight analog inputs are provided in the example firmware. These inputs accept analog inputs from GND 

to VDD which will correlate to 0% and 100% in the Driver Station. If the kit is powered by the USB bus 

power line, then the range will be from 0V to 5V. 

The standard names for analog inputs in game controllers are used for the 8 inputs: X, Y, Z, RX, RY, RZ, 

Slider, and Dial. 

Many different types of analog sensors are available but the most commonly used is a potentiometer 

(POT). A relatively high value potentiometer (e.g. 10K – 100K) should be used to reduce the current load 

on the system. For example, a 10K potentiometer connected to a 5V supply will consume: 

I = V/R = 5V/10K = 0.5mA 

The figure shows how a potentiometer would be connected to one of the 8 analog input pins. 

 

Digital Inputs (Buttons) 
The example firmware includes 22 digital inputs typically used for buttons or switches. The input pins on 

the PSoC are configured to have an internal pull-down resistor so when a button is not pressed, the pin 

will be pulled to ground. Therefore, the button must be connected to pull the pin high when it is closed 

as shown below. 

 

If you want an LED to turn on whenever a button is pressed or a switch is closed, it can be wired as 

shown below (some buttons have LEDs integrated in a single package). Use a current limiting resistor in 

series with the LED to prevent overloading the available system current. A larger resistor will reduce 

current consumption but will result in a dimmer LED. A typical resistor value of 1Kohm with a supply 

voltage of 5V will result in a current of 5mA and usually produces an acceptable LED brightness. 
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If you open the example project in PSoC Creator you will notice that the input pins are connected to 

schematic components called “Debouncer” – see the figure below. These are hardware debouncing 

circuits which prevent contact bounce on the buttons when they are pressed/released. Since PSoC has 

programmable digital resources available, it is possible to do the debouncing function in hardware which 

simplifies the firmware and frees the CPU to do other tasks. The ability to implement parts of the design 

using internal hardware is one of PSoC™ 5LP most powerful features. 

 

https://en.wikipedia.org/wiki/Switch#Contact_bounce
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Digital Outputs (LEDs) 
Digital outputs can be used for controlling indicators such as LEDs on the board. As mentioned above, a 

current limiting resistor should be included with each LED in order to reduce the current consumption. A 

typical connection for an LED is shown in the figure. 

 

Using the CY8CKIT-059 for Other Applications 
As mentioned previously, the PSoC™ 5LP contains a powerful ARM CPU, many analog functions (ADCs, 

DACs, Opamps, comparators, etc.), and many digital functions (PWMs, Timers, Counters, Debouncers, 

etc.) including fully programmable logic. 

Components are even provided for mixed analog and digital functions such as capacitive sensing 

(CAPSENSE™) which allows mechanical buttons to be replaced by touch sensors. Therefore, the 

applications for the PSoC™ 5LP are almost endless. It can be used for many purposes beyond the game 

controller example provided. 

If you want to explore additional uses for the PSoC™ 5LP device, check out the additional resources in 

the next section. There is a wealth of information ranging from application notes, video on-demand 

training, example projects, and community forums available for your use. 

If you want to see the full PSoC Creator project for the USB HID game controller, it can be found on the 

Infineon FRC users group page at: 

https://community.infineon.com/t5/FIRST-Robotics-Competition-FRC/gh-p/FRC 

Look for the topic titled “PSoC™ 5LP Operator Interface for the FIRST Robotics Competition” 

To open the project: 

1. Install PSoC Creator if you have not already done so. 

2. Double click on the file “CyController.cywrk” inside the CyController directory. 

https://community.infineon.com/t5/FIRST-Robotics-Competition-FRC/gh-p/FRC
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Additional Resources 

PSoC™ Creator 
The PSoC™ Creator home page can be found at:  

PSoC™ Creator Home 

There are many resource links including links to video training on YouTube Go to the YouTube site and 

search on “PSoC™ Creator”: find “psoc creator 101-lesson 1” From here you can follow the video 

lessons in order, or skip around depending upon your needs 

From inside PSoC™ Creator, you can find example projects by using the menu item File -> Code Example 

… From the window, you can filter for examples for a specific device family (PSoC™ 5LP for example) 

and for specific keywords. Each entry is a full PSoC™ Creator project including documentation.  

 

 

CY8CKIT-059 PSoC™ 5LP Prototyping Kit 
The main web page for the CY8CKIT-059 can be found at: 

CY8CKIT-059 home page  

A getting started with PSoC™ 5LP application note can be found here: 

AN7759 – Getting Started with PSoC™ 5LP 

Several tutorial videos on YouTube specific to PSoC™ 5LP are also available: 

https://www.infineon.com/cms/en/design-support/tools/sdk/psoc-software/psoc-creator/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-product_families&redirId=Product398
https://www.infineon.com/cms/en/product/evaluation-boards/cy8ckit-059/?utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-dev_kit&redirId=DK56
https://www.infineon.com/dgdl/Infineon-AN77759_Getting_Started_with_PSoC_5LP-ApplicationNotes-v08_00-EN.pdf?fileId=8ac78c8c7cdc391c017d071b8fb71dc6&utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-application_note
https://www.infineon.com/dgdl/Infineon-AN77759_Getting_Started_with_PSoC_5LP-ApplicationNotes-v08_00-EN.pdf?fileId=8ac78c8c7cdc391c017d071b8fb71dc6&utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-application_note
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USB HID 
A few application notes to simplify getting started using USB in PSoC™ are listed below. Each of these 

has a detailed document as well as fully functional PSoC™ Creator projects. 

AN57473 - USB HID Basics with PSoC™ 3 and PSoC™ 5LP  

AN58726 - USB HID Intermediate with PSoC™ 3 and PSoC™ 5LP 

AN82072 – PSoC™ 3 and PSoC™ 5LP USB General Data Transfer with Standard HID Drivers 

Note that many of the example projects are targeted to a PSoC™ 3 device. In order to use them with 

the CY8CKIT-059 it is necessary to change the target device. You can do this easily from Creator by using 

the menu item Project -> Device Selector. From the window that pops up, chose CY8C5888LTI-LP097 as 

the target device as shown below. Note that you may need to change the I/O pins when porting from 

PSoC™ 3 to PSoC™ 5 

 

 

Developer Community 
PSoC™ has an active developer community with many discussions on different topics. The community 

can be accessed from https://community.infineon.com/ Many experienced developers as well as 

Infineon engineers frequent the forums so they are an excellent way to find information and get 

https://www.infineon.com/dgdl/Infineon-AN57473_USB_HID_Basics_with_PSoC_3_and_PSoC_5LP-ApplicationNotes-v12_00-EN.pdf?fileId=8ac78c8c7cdc391c017d072d9ba7525f&utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-application_note
https://www.infineon.com/dgdl/Infineon-AN58726_USB_HID_Intermediate_with_PSoC_3_and_PSoC_5LP-ApplicationNotes-v11_00-EN.pdf?fileId=8ac78c8c7cdc391c017d072e541b52df&utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-application_note
https://www.infineon.com/dgdl/Infineon-AN58726_USB_HID_Intermediate_with_PSoC_3_and_PSoC_5LP-ApplicationNotes-v11_00-EN.pdf?fileId=8ac78c8c7cdc391c017d072e541b52df&utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-application_note
https://www.infineon.com/dgdl/Infineon-AN82072_PSoC_3_and_PSoC_5LP_USB_General_Data_Transfer_with_Standard_HID_Drivers-ApplicationNotes-v07_00-EN.pdf?fileId=8ac78c8c7cdc391c017d073bc5b95fcb&utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-application_note
https://www.infineon.com/dgdl/Infineon-AN82072_PSoC_3_and_PSoC_5LP_USB_General_Data_Transfer_with_Standard_HID_Drivers-ApplicationNotes-v07_00-EN.pdf?fileId=8ac78c8c7cdc391c017d073bc5b95fcb&utm_source=cypress&utm_medium=referral&utm_campaign=202110_globe_en_all_integration-application_note
https://community.infineon.com/
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questions answered. There is also an FRC user group that can be accessed at this link: 

https://community.infineon.com/t5/FIRST-Robotics-Competition-FRC/gh-p/FRC  

Troubleshooting 

KitProg Restoration 
If the board does not show up in PSoC™ Programmer as a KitProg device when connected to the board 

edge connector as described in the “Loading Firmware” section, it is possible that the KitProg has been 

overwritten. To correct this issue, follow the steps below. 

1. If not already done, connect the kit a PC via the board edge connector (KITPROG USB) and open 

PSoC™ Programmer. 

2. Navigate to the “Utilities” tab. 

3. If the “Upgrade Firmware” button is active (not greyed out) click on it to restore the KitProg 

firmware. 

 

4. If the “Upgrade Firmware” button is greyed out, remove the kit from the USB port and 

reconnect it while holding the reset button (labeled BOOT/RST). This will put the KitProg into 

bootloader mode.  

5. Once the kit connects as a bootloader you should be able to click the “Upgrade Firmware” 

button. 

6. When the firmware upgrade completes, disconnect and reconnect the kit without holding the 

reset button. 

https://community.infineon.com/t5/FIRST-Robotics-Competition-FRC/gh-p/FRC

